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The following changes have been made to DAT/EM products between Release 6.4 and Release 6.5. Please review these 
revisions made to the software and update your software to implement changes. 
 
As always, DAT/EM welcomes comments and suggestions from you, our clients, so please don’t hesitate to contact our 
support department at support@datem.com, or by calling in or faxing us with your requests. 
 
 
Operating Systems 
 
Release 6.5 is supported on Windows XP Professional, VISTA Ultimate, and Windows 7 Ultimate or Professional 
operating systems. Testing no longer occurs for Windows 2000. If you have a question, please contact Support. 
 
CAD Versions 
 
Release 6.5 has interfaces to the following 32-bit and 64-bit CAD versions: 

 AutoCAD: Autodesk 2002, 2004, 2005, 2006, 2007, 2008, 2009, 2010, 2011, and 2012 products. DAT/EM software will install 
for multiple AutoCAD products of different year numbers on the same computer; however, it will not install for multiple same-
year versions together. For example, it will not install for both 2012 and Map3D 2012. AutoCAD 2013 is not yet supported. 
BE ADVISED: Version 6.5 will be the final version to support AutoCAD 2000-2002 versions. If you use these old AutoCAD 
versions, please upgrade to AutoCAD 2004 or higher before DAT/EM’s next release. 
 

 ArcGIS: ArcMap 9.1, 9.2, 9.3 (service pack 1), 9.3.1(service pack 2) and 10 (service pack 4) 
 
 MicroStation: MicroStation V8 and V8 2004 Edition, XM, V8i Select Series 1 and Select Series 2, and Bentley Map Select 

Series 1 and Select Series 2 are approved. Select Series 2 is recommended over Series 1. Select Series 3 is not yet 
supported. 

o Note for Select Series 1-to-2 upgrades: If you upgrade to MicroStation or Bentley Map from Select Series 1 to 
Select Series 2, you must re-install any DAT/EM software after installing Select Series 2. The Select Series 2 
software does not remove existing DAT/EM applications, and they will appear to load correctly. However, the 
applications installed for Select Series 1 may not work well when you use specific commands. Reinstalling the 
DAT/EM software installs new Select Series-2-specific DAT/EM applications. 

 
 

Hardware Locks/Dongles 
 
Please install Microsoft Updates and Service Packs for your operating system before applying lock reset programs. Network licensing 
should have the same Sentinel driver version on both the server and the local computers running the software. 
 
 
SUMMIT EVOLUTION 

 

 
1. Auto-load next model was added for SUMMIT orthophoto imagery projects. 
 
2. The Control Editor has several fixes to better display and hold settings for latitude-longitude coordinates. 

 
3. If Relative Orientation Tie Points is active with the side-by-side viewing mode on, Aligns Images works. In 

version 6.4, it only worked if side-by-side mode was off. (Aligns Images is located on the Align toolbar or a button 
set to Type=Plotter, Action=Align). 
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4. Any viewport can be set to show a 3D vector superimposition (SI) view. This type of view is similar to the existing 
“3D Vector Split Window” view, except that the entire view is a 3D SI view. Right click on a viewport and select 
Show 3D SI in view port. Right click and select again to turn it off. You can also drag models on top and they will 
replace the SI view. Like other viewport settings, these views will be stored in the project file and restored the next 
time SUMMIT opens the project. 

 

 
Example of Show 3D SI in Viewport on in three out of four viewports 

 
5. It is now easier to define flight strips using Add Strip in the Project window. Previously, each image in the strip 

required manually selection, and the dialog would close after each strip was added. There is a new Regular 
Expression automatic selection option. If there is a file naming convention that indicates the strip number, enter it 
and select the Select button. All image filenames that contain that string will be selected automatically. In the 
following example, “10_” indicates strip 10 and can be used to select the files. The dialog does not close after 
Add; continue adding strips until finished. 

 

 
Example of Regular Expression automatic filename selection 

 



DAT/EM Systems International RELEASE 6.5 Product Notes 

 3

6. The Project Edit dialog for Aerial projects can now sort the images by missing and found image files. Click on the 
Files column title and choose the sort method: Ascending for alphabetical A-Z, Descending for Z-A, and By not 
found, then found for missing images – indicated by a red “X” – listed first. 

 

 
Sorting images in the Project Edit dialog for Aerial Projects 

 
7. SUMMIT’s Project Import (File>Import) tools have the following updates: 

a. The Z/I SSK Project import function now replaces alphanumerically named fiducials with numbers and 
imports them correctly. 

b. Select File>Import>BLK file to import BLK files produced by ERDAS Stereo Analyst. SUMMIT imports 
ERDAS readj7.blk files that do not have interior distortions. If you have a BLK file that has interior 
distortions, please send it to DAT/EM Support for further development. 

c. SocetSet SUP LSR projects has been added to the File>Import>Socet Set from SUP only option. It will 
correctly import LSR projects that use U.S. feet or meters units. It will import automatically without any 
additional settings. You will know you have an LSR project if the resulting model gives Latitude-Longitude 
ground coordinates. After importing, do three things: 

 
1.) Look at SUMMIT's coordinate display. If it's latitude-longitude, continue. 
2.) In SUMMIT, open the Tools>Google Maps tool. Check that the location matches. They will 

never match exactly, but they should be close. If they are far off or the Google Maps location 
shows DAT/EM's office in Alaska, then units other than U.S. Feet or meters were used in the 
SocetSet LSR project; send the project to DAT/EM for further development. If SUMMIT and 
Google Maps are close, continue. 

3.) In SUMMIT, apply a coordinate transformation from WGS84 (Lat-Long) to the desired output 
system. Save the project. 
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8. SUMMIT EVOLUTION aerial projects have the following orientation and orientation-related changes: 
 

a. In addition to “IO”, “EO” or “AO” designators next to images on the Project View window’s Images tab, 
“RO” has been added. Although Relative Orientation really only exists between two images, SUMMIT 

EVOLUTION will show “RO” if the image has some relative points. In addition, checking for AO (Absolute 
Orientation) status was improved for speed when opening a SUMMIT EVOLUTION project. 

 
b. The Exterior Import Wizard was fixed to ignore a comma delimiter when the comma is part of a string 

enclosed in quotation characters. For example, if a file contains “Nov. 30, 2010” enclosed in quotation 
marks, the comma inside the quotation marks will be ignored and the import will proceed correctly. 

 
c. The Project Edit dialog for aerial projects now has an Average Elevation choice. The default is to use the 

average elevation from the control file. If there is no control file associated with the project, set this to Key 
In and enter the average or typical elevation value for the project. This value is used for several important 
functions, such as setting the initial cursor elevation as the first model opens, determining when to open 
the next model as the cursor reaches the edges of the current model, and calculating 2D SI position. 

 
d. There was a relative orientation viewing problem introduced in version 6.4. The viewing rotation has been 

corrected to properly display digital camera model images that are 90 degrees rotated with respect to 
each other. 

 
e. If Automatically select best stereo view was on for some projects with exterior orientation and 

irregularly overlapped images, the overlap indicator could fail and ground coordinates would not be 
available. A correction has been made so that small overlap areas remain oriented and work properly with 
the best stereo view setting. 

 
f. Control Transfer between two SUMMIT EVOLUTION instances has the following fixes: 

 
1.) Control Transfer now completely deletes a point with the “X” button below the point list. 

Previously, it would remove the point from the list, but continue to report that the point was 
already in use if you tried to add the same point name later. 

2.) Control Transfer now correctly changes a point when the point is remeasured. Previously, it 
would update the position in the to-orient SUMMIT instance, but would use the old 
measurement from the oriented SUMMIT instance. Now it uses the new positions from both 
SUMMIT instances. 

3.) Control Transfer could report that a point identifier was already used when it had not been 
used in the current project. Note that this could still happen in older projects, but will not 
happen in projects started in version 6.5 and higher. 

4.) Control transfer could have problems if SUMMIT was set to the system mouse digitizer and the 
system mouse was single-right-clicked to control the SUMMIT cursor. Control Transfer would 
activate dialogs that the mouse could not control, or mouse clicks would accept the dialog 
buttons and digitize a point in the SUMMIT view at the same time. This has been fixed. 

5.) Control transfer now only requires a relative orientation if 2 ½ or 3 points are to be measured. 
A relative is not needed if 4 or more points are to be measured. Residuals are shown for 4 or 
more points. DAT/EM recommends measuring 4 or more points. 

 
9. Terrain following now saves its previously used DTM files between SUMMIT sessions. If a file is not found, it will be 

displayed in red. 
 
10. The DTM Collection mode within SUMMIT’s Drawing Objects tools now correctly opens models when the first or 

next “drive to” point is outside the currently open model. Previously, it malfunctioned when the DTM boundary 
overlapped more than one model, causing a “move to” that needed a model change. 
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11. SUMMIT EVOLUTION satellite projects have the following changes: 
 

a. In a single-image RPC satellite project, the solution from measured control points in the Tie Points dialog 
is now correctly applied. Previously, the Tie Points solution was shown correctly in the Tie Points dialog 
and measurements were correctly saved in the project, but the solution was removed when the Tie Points 
dialog closed. For example, if the Tie Points solution shifted the RPC +5 meters directly onto a measured 
control point during Tie Points, it would shift -5 meters back to its original RPC solution location when Tie 
Points closed. This was a problem for single images only; stereo images did not have this problem. With 
this fix, an orthophoto may be created from a single-image RPC project using the corrected RPC ground 
coordinates. 

 
b. In satellite RPC and ALOS projects, a coordinate conversion may now be applied before measuring 

ground control points in the Tie Points dialog. Previously, it did not apply the conversion correctly to the 
solution for measured ground control points that were expressed in the destination coordinate system. 

 
c. The ALOS satellite project type may now be used with the PROJECT VIEWER overview and 

orthophoto/mosaic tools. 
 

d. The SPOT-5 Project Edit dialog’s “Add Multiple” button now operates correctly. 
 

e. CORONA is a new satellite project type for CORONA KH-4A imagery. This uses imagery from the U.S. 
CORONA satellite program that operated between 1959 and 1972. Prepare the imagery using 
File>New>Photo Stitch. Each resulting stitched image should look like a long strip similar to this: 

 

 
 
When the images are ready, use File>New>CORONA KH-4A. Please contact DAT/EM for detailed 
instructions if you are planning to use the CORONA project type. 

 
12. CONTOUR CREATOR no longer crashes when there are many duplicate points. 

 
13. The STEREO MATE GENERATOR (SUMMIT EVOLUTION > Imagery > Generate Stereo Mates) has a new “Color RGB 

image” option. Input files that have RGB color can now carry over the color as well as the intensity into the 
generated stereo mate. 

 

14. POINT TRANSLATOR‘s “Clip by Polygon” is no longer limited to 99 or fewer polygons. Previously, when a vector file 
contained more than 99 polygons, it would only clip the first 99 polygons. 

 

15. IMAGE CREATOR has the following changes: 

a. 16-bit, 4-band images no longer lose the fourth band when reducing to 8-bit. 

b. If the input file is in JPG format and the output is set to TIF and PYR, it now correctly makes the TIF file. 
Previously, it made the PYR file only. 

c. In some cases, inputting a 1X TIF and setting the output to PYR could create a filename_new.tif file when 
it was not needed. This has been fixed. 

d. Support for UltraCAM Eagle imagery was added. 
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16. PROJECT VIEWER / ORTHO+MOSAIC has the following changes: 
 

a. The online help was updated for PROJECT VIEWER. NOTE: Any DATEM dialog containing a “?” in the 
upper right corner should display tips on settings and explanations of options available. Click on the “?”, 
then click on the item in the dialog you want more information about, and a brief description will display. 

 
b. The Create Mosaic dialog’s Image tab offers Zoom Levels file format choices. PYR writes the 1X alone 

to the TIF and writes the zoom pyramids to a separate Inpho-format PYR file. OVR writes the 1X alone to 
the TIF and writes the zoom pyramids to a separate ESRI® ArcGIS®-format OVR “overview” file. Inside 
writes the 1X and its zoom pyramids to a single TIF file. Please note that PYR and OVR files are the 
same format; the only difference is their file name extensions. 

 
c. In some cases depending on the boundary definition, an orthophoto could be made with the background 

color in the first row of pixels. This is fixed to use a row of actual orthophoto colors. 
 

d. Single-image RPC satellite projects will now generate an orthophoto at the corrected RPC ground 
coordinates instead of the original RPC ground coordinates. See also number 9 above. 

 
e. The ALOS satellite project type may now be used with the PROJECT VIEWER overview and ORTHO+MOSAIC 

orthophoto and mosaic tools. 
 

f. “OVR” is a new output option for orthophoto and mosaic image zoom levels. OVR may be used as an 
ArcGIS 10.x overview file. 

 
g. Mosaic image boundaries now have two settings, Inclusive and Overlapped, to determine which pixels 

at the image boundary to include or exclude. Use the “?” in the dialog for more information. 
 

 Inclusive includes all the pixels inside the boundary vectors plus all the pixels crossed by the 
boundary vectors. This method is recommended. Use this method in any of the following 
cases: The boundaries have a 1-pixel-width gap between each adjoining boundary, the 
boundaries are not rectangular, and/or the boundaries are not oriented to north. 

 Overlapped includes all the pixels inside or at least partially inside the boundary vectors 
minus the uppermost row and rightmost column of pixels. The purpose of removing the 
uppermost row and rightmost column of pixels is the prevent 1-pixel-wide duplication of pixels 
along the edges of adjoining images. Use this method only if there is a grid of rectangular 
boundaries that share edges and are oriented to north. 

 
h. SUMMIT EVOLUTION LITE EDITION’s PROJECT VIEWER no longer creates a …\Settings_<project 

name>\<project>.omXml file. The Save button has been deactivated for LITE. 
 
 
 
LANDSCAPE 
 

 
 

1. In the keypoints filter, if the same minimum filtering was applied twice to the same file in succession, all points 
could be removed. This has been fixed. 

 
2. DAT/EM LITESCAPE is a new, free application that is essentially a viewer version of LANDSCAPE. It is provided free 

with any DAT/EM software installation. 
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3. There is a new “Filter Only” Selection Set choice. Previously, a vector file was required in order to make a 
Selection Set. 

 
4. The following new filters have been added to the Edit Tools>LIDAR Point Edit tools: 

 

 
New filter tools in Point Edit 

 
a. Air Points: Classifies points that are clearly higher than the median elevation of surrounding points. It can 

be used to classify “noise” up in the air. When possibly classifying one point, this routine will find all the 
neighboring source points within a given search radius. It will compute the median elevation of the points 
and the standard deviation of the elevations. The point will be classified only if it is more than Limit times 
standard deviation above the median elevation. Comparison using standard deviation results in the 
routine being less likely to classify points in places where there is more elevation variation. 

b. Low Points: Classifies points that are lower than other points in the vicinity. It is often used to search for 
possible error points which are clearly below the ground. This will compare the elevation of each point 
(center point) with every other point within a given xy distance. If the center point is clearly lower than any 
other point, it will be classified. Sometimes you may have a higher density of error points. If there are 
several error points close to each other, those will not be detected if searching for single low points; 
however, this routine can also search for groups of low points where the whole group is lower than other 
points in the vicinity. 

c. Isolated Points: Classifies points that do not have very many other points within a 3D search radius. This 
is useful for finding isolated points up in the air or below the ground. When possibly classifying one point, 
this routine will find how many neighboring points there are within a given 3D search radius. It will classify 
the point if it does not have enough neighbors. 

d. Below Surface: Classifies points that are lower than other neighboring points in the source class. This 
routine can be run after ground classification to locate points that are below the true ground surface. The 
algorithm for this routine can be outlined as follows: 

 For each point (central point) in the source class, find up to 25 closest neighboring source 
points. 

 Fit a plane equation to the neighboring points. 
 If the central point is above the plane or less than Z tolerance below, it will not be classified. 
 Compute standard deviation of the elevation differences from the neighboring points to the 

fitted plane. 
 If the central point is more than Limit times standard deviation below the plane, classify it into 

the target class or delete the point. 
 

e. Water Classify: Classifies flat or almost flat water. 
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DAT/EM CAPTURE for ArcGIS 

 
NOTE: Compatible with 32-bit versions of ArcGIS 9.1, 9.2, 9.3.1, and 10 (each with the latest service packs installed) 
 

1. Undo is now working properly after DAT/EM’s Cut Polygon Features. Edits made with Cut Polygon Features are 
now prompted for a Save upon Stop Editing. 

 
2. Autolist has the following changes: 

 
a. It now properly lists the vertices of an object that has been edited with Shift Vertex in Z only. 
b. It now correctly identifies the length and closed status for ArcGIS 10's vertical polylines. 

 
3. When Clip Segments turns on, Clip Polygon (the scissors icon) is now turned off automatically. These are 

incompatible tools. 
 

4. The DAT/EM Capture Options > Squaring tab > Minimum offset distance for vertical planes entry field is now 
wider to show more digits and decimal places. 

 
5. There is a new Zoom with Summit checkbox on the DAT/EM Capture Coordinates dialog. This dialog is 

activated from the DAT/EM Capture Tools toolbar:  
 

 When checked on, the ArcMap view zooms in and out when SUMMIT EVOLUTION zooms in and out. 
The zoom ratio between them is set with the slider below the Zoom with Summit setting. 

 
 When not checked, ArcMap’s own view scale does not change when SUMMIT EVOLUTION zooms in 

and out. ArcMap pans when the cursor reaches the edge of the view. Select the ArcMap view scale 
on Arcmap’s Standard toolbar. 

 
 

       
 

 
6. Representation symbology is now displayed in SUMMIT’s superimposition. 
 
7. The DTMIt command now works together with SUMMIT to properly open the next model when the cursor moves 

into the next model area. In previous versions, either the wrong model would open or it would crash. 
 

8. The following problem was fixed: When individual Feature Classes (shapefiles or GeoDatabase Feature Classes) 
were loaded into the ArcMap Table of Contents (TOC) and were not placed into any sub-group or layer 
organization, then the attributes placed as Labels in ESRI would display in ESRI and superimposition (SI) 
correctly; however, if all or some of the individual Feature Classes were organized into TOC sub-groups or 
contained within an ESRI layer file, then those features' text attributes would not display in SI. 
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9. In previous versions, the Trace Single tool would choose a side of the polygon to follow, and there was no way to 

change it. Now you can pick (snap to) the second trace end again in the same location to toggle the trace route to 
the other side. Toggle any number of times by picking in the same place again. Continue drawing when the 
indicated route is correct. 

 

 
 
10. AIRFIELD3D has the following upates: 

a. ArcMap no longer crashes if the Apply keypad or digitizer button is pressed while digitizing an obstruction 
area polygon. 

 
b. The VGRPS (Runway Primary Surface) is now divided into thirds to comply with the specifications in 

section 2.7.1.2.1 of the FAA AC 150/5300-18B document. The area thirds are displayed in 
superimposition and are exported to the ObstructionIDSurface layer. The position of the cursor is noted 
with text, “(1/3 section)”, “(2/3 section)”, and “(3/3 section)” in the Airfield3D display.  

 
c. The VGAS (Approach Surface) is clipped around the VGPS (Runway Primary Surface) when it is 

exported to the ObstructionIDSurface layer. This change does not affect the calculation of which surface 
the cursor is located in; it has always correctly assigned the priority of the surfaces where they overlap in 
(x,y). The outline now looks similar to this: 

 

 
The exported VGAS is clipped around the VGPS 

 
d. AIRFIELD3D can now recalculate all automatically generated field values for all currently existing objects 

on the Obstacle layer. On the Airfield3D dialog on the ArcMap side, select the Recalculate button, . 
This should be used after some correction has been made to the input such as the runway centerline or 
height model after obstruction data has been digitized. The recalculate function refreshes the 
automatically calculated distance and height field values, such as “From runway center” and “From 
runway end” values. 
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e. There are new report generation capabilities. On the Airfield3D dialog on the ArcMap side, select the 

Reports button, . Check on the desired reports and select Generate. 
 

 
 

f. The One Engine Inoperable (OEI) surfaces with their division lines have been added. These are 
described in Section 2.8 of the FAA AC 150/5300-18B document. Each runway’s OEI may be turned on 
or off from the SUMMIT-side Airfield Select List. Each runway’s OEI appears in the list and is off by default. 
When the OEI is turned on and the cursor is in the xy area of the OEI, SUMMIT’s Airfield3D information 
text shows the OEI area, even if other surfaces are also on and the cursor is also in the area of one of the 
other surfaces. When the surfaces are exported to the ObstructionIDSurface layer in ArcGIS, the OEIs 
are included. 

  

 
Summit zoomed out to show the OEI areas and divisions for one runway 
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The OEI areas and divisions are included in the export to the ObstructionIDSurface layer in ArcGIS 
 
g. In previous versions of Airfield3D, the quadrant lines described in the FAA AC 150/5300-18B (18B) 

document section 2.7.1.2.6 were centered on the runway center point. Now they are centered on the ARP 
(Airport Reference Point). The 18B is somewhat ambiguous on the location of the center point, so 
DAT/EM complied with a customer request to center it on the ARP. 
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DAT/EM CAPTURE for AutoCAD 

 
 

NOTE: Compatible with 32-bit AutoCAD 2000-2012 versions with the latest service packs. 
 Compatible with 64-bit AutoCAD 2008-2012 versions with the latest service packs. 

AutoCAD 2013 is not yet supported. 
BE ADVISED: Version 6.5 will be the final version to support AutoCAD 2000-2002 versions. If you use these old AutoCAD 
versions, please upgrade to AutoCAD 2004 or higher before DAT/EM’s next release. 
DAT/EM software will install for multiple AutoCAD products of different year numbers on the same computer; however, it will 
not install for multiple same-year versions together. For example, it will install for AutoCAD 2011  and AutoCAD Map3D 2012 
together, but it will not install for both AutoCAD 2012 and AutoCAD Map3D 2012. 

 
1. The much-awaited *NEW* MAPEDITOR for AutoCAD is officially released. This MAPEDITOR offers a suite of editing 

tools that include all the functionality of the old MAPEDITOR plus much, much more. These tools may be run on 
selected objects, whole layers, or complex selection sets. They may be run interactively or in batch. 

 
a. The new MAPEDITOR is for AutoCAD 2007 and higher. The old MAPEDITOR will continue to be installed for 

AutoCAD 2006 and lower. 
 
b. The keyin to start the new MAPEDITOR is MapEd. 

 
c. The new application name is EditMap<version>.arx. 

 
d. The new MapEd command is called by DAT/EM’s updated menus (see item 4 below). If you have custom 

menus or keypad overlays that start the old ME command, please change these to activate MapEd 
and/or load EditMap<version>.arx. 

 
e. The MapEditor Operation Manual may be downloaded from the Support area of the DAT/EM website. 
 
f. Since the 6.4 beta version of the MAPEDITOR, there is a new Offset Polyline(s) tool. It offers 3D offset of 

polylines with options for right or left side, XY distance, Z distance, and offset layer. Its offsets look good 
when viewed in the XY plane. It can offset straight and arc segments. For example, it can make offsets 
from a polyline created by DAT/EM CAPTURE’s AutoArc2D or AutoArc3D command. 

 
g. Since the 6.4 beta version of the MAPEDITOR, there is a new Spotinterp tool. It offers to insert a spot 

elevation based on the Z of selected surrounding objects. This tool is located in the MapEditor dialog, but 
it is interactive only; it may not be added to a batch file. 

 
h. Since the 6.4 beta version of the MAPEDITOR, there is a new SlopeCheck tool. It finds and/or edits 

polylines that have monotonicity errors. A monotonic polyline has elevations that only increase or only 
decrease between the endpoints, but don’t go both up and down. 

 
i. Since the 6.4 beta version of the MAPEDITOR, there is a new Cleanup tool. It replaces two commands that 

used to be in separate ARX files: Cleanup and CheckLineElevation. It finds and either deletes or fixes 
zero-length polylines, flat 3D polylines, and nearly flat 3D polylines. 

 
j. Since the 6.4 beta version of the MAPEDITOR, Resize Block and Resize Text have changed names to 

Modify Blocks and Modify Text. Both commands have many additional settings, such as block scales 
and text justification. 

 
k. Since the 6.4 beta version of the MAPEDITOR, the DAT/EM SCHEDULER service has a new Options dialog. 

It is possible to set default paths and schedule times for new events. 
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2. The DAT/EM Reverse command has been renamed to DatemReverse for all versions of AutoCAD. This was 
done to separate it from AutoCAD’s own Reverse command, which exists in AutoCAD 2010 and higher. The 
installed DAT/EM menus have been updated to call DatemReverse. We ask users to please change their custom 
menus and keypad overlays if they would like to call the DAT/EM version of the command. 

 
3. The DAT/EM installation routine was fixed to place all the correct files for use with AutoCAD 2010 on 64-bit 

computers. Previously, the wrong wintab driver file was installed and unnecessary 32-bit files were present. 
 

4. All DAT/EM CUI and CUIX menu files for AutoCAD versions 2007—2012 have been updated. The installation 
routine will now clear any compiled MNR files from the \Program Files\<AutoCAD version>\datem folder. After 
installation, when AutoCAD starts with the DAT/EM partial CUI(x) files added, it will compile new MNRs. More 
BMP files are placed in the \Program Files\<AutoCAD version>\datem\bmp folder to support the new menus.  

 
 Do you use custom menus? Please back them up before upgrading your DAT/EM software. Do not 

store custom menus in the \Program Files\<AutoCAD version>\datem folder. 
 
 Please note that it is no longer necessary to add both the Datem*.cui(x) and the MapEd*.cui(x) at 

the same time. MapEd*.cui(x) is for stand-alone MAPEDITOR installations and optional for DAT/EM 
CAPTURE. 

 
 Please note that each Autodesk AutoCAD version seems to have different bugs with menus; if you 

have trouble, contact DAT/EM Support for problem solving tips. Be sure to mention the version of 
AutoCAD and whether it is installed on a 32-bit or 64-bit computer. 

 
 
 
DAT/EM CAPTURE for MicroStation 

 
Changes apply to Capture for MicroStation V8/2004 Edition, MicroStation XM, and MicroStation V8i Series 1 or 2 on 32-bit and 
64-bit operating systems. Note: 

 MicroStation V8 and V8 2004 Edition: Version should be 08.05.00.34 or higher. 
 MicroStation XM and V8i Series 1: XM version should be 08.09.04.88 or higher. 
 MicroStation V8i, V8i-based Bentley Map and Map Enterprise Select Series 1 and Select Series 2: Select Series 2 is 

recommended over Series 1.  
o Note for Select Series 1-to-2 upgrades: If you upgrade Select Series 1 to Select Series 2, you must re-install any 

DAT/EM software to get the Select Series-2-specific DAT/EM applications.  
o Select Series 3 is not yet supported. 

 
1. CRSELECTION is a new command to copy and rotate a group of selected elements. It is similar to the 

CRBUILDING command, except that it accepts more element types and multiple objects at one time. It works on 
all elements except shared cells. It includes elements in reference elements from attached files. To run: 

a. Pre-select any number of elements (except shared cells). 
b. Select the copy origin. 
c. Drag the copied elements to the new location. 
d. Select the new location. 
e. Drag and select the rotation, which also finishes the task. 

 
2. SELECTEDSETZ and SELECTEDSETZ <elevation> are two new commands that set the elevation of objects that 

are currently selected in MicroStation. First, select the objects. Set the stereoplotter or MicroStation AZ= elevation 
(For option b. only). Key in either of the commands: 

 
a. SELECTEDSETZ <elevation>. Applies the keyed-in elevation value to every selected object. For 

example, “selectedsetz 125.0” sets the objects’ elevation to 125.0.  
b. SELECTEDSETZ. Applies the active elevation to every selected object. 
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3. The ability to apply “All Linework” as opposed to “All Elements” was added to the MAPEDITOR Selection Set Editor. 

 

 
 

“All Elements” could include additional elements such as cells. Using “All Linework” limits the selection to any time 
of linear element. Element types include 3, 4, 6, 11, 12, 14, 15, 16, 27, or line, line string, complex string, shape, 
complex shape, arc, ellipse, curve, and bspline curve. 

 
4. The Tentative Label display was changed as follows. 

 
a. The text for tentative labels is now bold. 
b. In MicroStation versions XM or higher, colors are accessed via color descriptors. The mapping may vary 

based on the color table that is attached. Some of the label colors were not correct as a result. This has 
been fixed. 

c. A new Tentative Label Height parameter allows the user to set tentative labels to a larger text size. This 
parameter is not available in V8. 

 

 
 

 
5. A 3DOFFSET problem was fixed. Occasionally, the command would offset only a portion of a complex element 

instead of the full element. 
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6. BREAKLINEFILTER has modifications as follows: 
a. It can now process breaklines and boundaries from reference files. 
b. The limited “Points and Shared Cells to Process” selection method has been replaced by a selection set. 
 

 
 

7. CHANGE ATTRIBUTES INTERIOR has a new option to use boundaries from reference elements in attached 
files. This change is in both the interactive and the MAPEDITOR batch file version of the dialog. 
 

 
 

8. CRBUILDING now works on elements with more than 101 vertices. It was also updated to work with MicroStation 
V8i and Select Series 2. 
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9. DEPRESSION can optionally extract depression information from cells, points, and/or breaklines in attached 
reference files. 

 
 
10. EZEDIT has several improvements. 

a. The Apply button has been removed. All actions are applied when completed. 
b. Vertex display can be quickly toggled in the main dialog. 
c. When Fix Z is checked on, a Pick Z button may be used to set the Fixed Z value based on the elevation 

of a picked element. Fix Z is useful for editing elevation of whole elements or inserting or moving vertices. 
d. Previously there was a button called Current Z. This was changed to Summit Z for clarity. 

 

 
 

e. The Whole element edit option in EZEDIT has had the Clip selection changed to Delete Partial. 
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EZEDIT changes, Continued. 
f. Arc editing to move vertices on an Arc element or sub-element no longer requires a separate Pick to 

determine which part of the Arc will be edited. Previously, Arc editing needed the user to select from Arc 
endpoints, midpoints and bounds. Now, the original element picked will be assessed to determine how 
the arc is edited. 

1. If an Arc endpoint is near the original Pick position, the endpoint and any adjacent sub-
element is moved. 

2. If the Arc midpoint is near the original Pick position, the Arc will be rescaled, maintaining 
its original shape and endpoints. 

3. If any other position of the Arc is selected, the Arc will be reshaped based on where the 
picked point is moved, maintaining the original endpoints. 

 
g. If a Move Vertices Pick position is on a linear sub element (of a complex element) nearest the vertex that 

intersects an adjoining Arc sub element, then both the Arc and the sub element are corrected. 
h. Improved runtime performance and stability modifications are included. 
i. Elements with irregular elevations are easier to edit in Vertex Mode. Previously, the active elevation was 

used when resolving the nearest vertex, so the wrong vertex was sometimes chosen. Now the 
calculations are adjusted to the plane of the active View. In rare cases, this caused V8k or SS2 to crash. 

 
11. JOINIT has a new interactive dialog. 

 
a. An improved method of smoothing added connections was added. Because the results have improved, 

there are only two options for joining elements: Add Vertex or Blend Endpoints. 
b. To simplify reference file handling, “to elements” are either in the master drawing or in attachments. 
c. Batch functionality for JOINIT also has an updated interface. 
 

     
JOINIT’s version 6.5 dialog layout, interactive and MAPEDITOR batch file versions 
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12. MECLIP has the following changes: 
a. It can now process complex boundaries that contain arcs. Previously, it would skip such elements.  
b. A problem was fixed in exterior clipping for boundaries that are located in reference files. 

 
13. MEXPORT (“Export to File”) has the following changes: 

a. MEXPORT has been fixed so that its XYZOUT format dialog returns to the MEXPORT dialog. Previously, 
it would return to MicroStation, thus ending the MEXPORT command without the possibility to run the 
export. 

b. MEXPORT’s XYZOUT settings have been fixed so that they will work the first time they are used, that is, 
with an initial clean registry for that item. 

c. Custom style settings are now saved. 
d. “By Level” settings are now handled consistently. 
e. Level names longer than 20 characters may now be used. 
f. The Export Item dialog now accepts wildcards for level, color, style, and weight. The wildcard character is 

the asterisk, *. 

 
MEXPORT * wildcard for level, color, style, and weight 

 
14. “SPOTINTERP USESET <selection set name>” is a modification of the previous “SPOTINTERP USESET” 

command.  Previously, it would correctly set the toggle to use selection sets, but it would also reset the set name 
to the first selection set in the current alphabetical list of sets. Now it both sets the toggle and provides a specific 
set name. Example keyin: spotinterp useset breaklines. 

 
15. ZCHECK has the following changes: 

a. The “Any differences ≥ 0” setting no longer misses intersections where the elevation difference is zero. 
b. It no longer marks twice if the “from” and “to” sets are the same. 

 


